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What is KeyStage? 

 

KeyStage is a Master Instrument Controller iOS (iPad) App through which you can control and play 

both keyboard internal sound engines and iOS virtual instruments. Check out the App’s description 

at the App Store https://apps.apple.com/gb/app/keystage/id1406132634 

 

How can the Roland V-Combo VR keyboards work in conjunction with KeyStage? 

 

There are 3 areas where Roland VRs and KeyStage can work together: 

 

1. Playing sounds in the Roland VR’s GM2 sound engine 

 

2. Translating the Sysex output of the VR’s hard organ controls (drawbars etc) into the Change 

Control’ (CC) numbers s required to control iOS virtual organs 

 

3. Playing other iOS virtual instruments. And there are thousands out there! And these can be split 

and layered with sounds in the Roland VR’s GM2 sound engine if required 

 

1. Playing the Roland VR GM2 sound engine via KeyStage 

 

First some advantages and disadvantages 

 

Advantages 

 

ALL the sounds available in the Roland VRs, including the main keyboard sound engine plus the many 

‘hidden sounds’ unearthed by Frank V-Combo Editor, are available as GM2 sounds and can therefore 

be a played on MIDI Channels 5 to 9, 12, 14 &15 with MIDI IN Mode 2 selected on the VR. 

 

You can escape the limitations of the VR’s Registrations. KeyStage is based on ‘Song’ files which can 

have many ‘Sections’ and each ‘Section’ can have many ‘Tracks’ with each Section/Track interface 

containing a ‘Part’ which can contain either a VR GM2 patch or an iOS virtual instrument patch. Thus 

you can forget being restricted by 40 Registrations with each one containing just 2 sounds - now you 

can easily have many hundreds of Songs/Sections with each one having many sounds layered (one 

for each of MIDI channels 5 to 9, 12, 14 &15). Also, there’s no need to split the Keyboard on the VR 

anymore - you can set the range of notes to be played in each KeyStage ‘Part’.  

 

The following image is the ‘Main View’ of a KeyStage song  file of a song in 6 sections (3 intros, verse, 

chorus, and outro) with a total of 9 tracks (instruments in the left hand column) of which a maximum 

of 8 are layered (in the Outro section). The ‘SL JP6 Fx’ patch is the only VR main keyboard sound 

(although accessed through the GM2 sound engine), all other patches being VR GM2 or VR GM2 

Atelier sounds. Note that only channels 5 to 9, 12, 14 &15 are used with a separate channel per 

track. Note also that some of the patches are confined to specific ranges of the keyboard. 
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KeyStage has its own Mixer so if you’ve got a Song with, say, 9 Tracks in it, you can mix the volume of 

each. The above image shows the 6 tracks active in the Chorus section, with all tracks, apart from 

‘Wind Fx’, set at full volume. 

 

 
 

KeyStage has a ‘Live Console’ which you use when playing live. This can show various data, and the 

above image shows the ‘Info’ selection, basically the Tracks and Parts being played for a particular 

song section. However the most common selection is probably ‘Media’, this containing PDF or JPG 

charts or scores which can be assigned to each Section. As a music reader it’s rather rudimentary, 

but if you want to use a more advanced music reader (such as ForScore or Mobile Sheets) you can 

and you can configure your music reader to change KeyStage Songs or Sections too. Or you can use a 

Bluetooth pedal to change KeyStage Songs or Sections. 

 

 
 

An important feature of KeyStage is its ‘Translators’. These modify MIDI signals passing between the 

keybed and instruments (ei ther hard or soft instruments). The above image shows KeyStage’s 

‘Range Limiter’, one of three ‘Standard Translators ‘and which can be set to limit the range of the 

keyboard for any one ‘Part’ (patch).  In addition to its Standard Translators, KeyStage also enables 

users to write their own ‘Custom Translators’ which allows users to adapt their keyboards to do - 

pretty much anything they want to do! And if they can’t do it, a simple scripting language is provided 

to allow users to go a stage further. 

 

KeyStage supports Set Lists, however there are two distinct ways of using it - (1) the ‘one song per 

Song file’ approach, which requires Set Lists to be set up, or (2) the ‘single Song file’ approach in 
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which each song is a single Section (or possibly 2 or 3 adjacent Sections). Using this latter approach 

you don’t need Set Lists as such, you just drag the Sections into the order you want them for an 

upcoming gig. 

 

Disadvantages 

 

 
 

The principle of a master instrument controller such as KeyStage is that it is in total control and that 

all information, including all note information, passes through it (see above image). Ideally this is 

done by enabling a ‘Local Off’ control on the keyboard. However, the Roland VRs don’t have a ‘Local 

Off’ control. Luckily though, the Roland VRs have separate volume controls for each of Organ, Piano 

and Synth so, with Organ and Piano modes both selected, if you zero the volume of these two zones, 

you’ve pretty much achieved the same thing - sounds will be created locally but you won’t be able to 

hear them. 

 

Although all the VR’s main keyboard sounds are available as GM2 sounds, they don’t have any of the 

VR’s FX. So if you want FX you have to add it from one of the many IOS FX apps available.  

 

What you need to play the Roland VR’s GM2 Sound Engine through KeyStage 

 

An iPad. The bigger and most recent, the better. As I write, KeyStage’s minimum requirement is iOS 

13.0. KeyStage is not available for Android. 

 

iPad mount. You’ve obviously got to mount the iPad somewhere and the choice is either a dedicated 

iPad mount on a freestanding stand, or a music stand such as the Thomann SP-320, which works well 

with the 12.9 inch (larger) iPads and which fits the VR-09 perfectly (but unfortunately not the VR-

760). 
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The KeyStage App. You might want to get started with KeyStage Lite 

https://apps.apple.com/gb/app/keystage-lite/id1437899019 (freeware). This obviously has 

limitations however the description on the App Store doesn’t state what these are. 

 

Physical Connections. This will depend on your iPad. Recent iPads have a USB C port and these 

require a powered hub dock which will require a power adapter (minimum 60 watts recommended) 

and a (typically 2 metre) USB C power lead. If you get a hub with 3.5mm audio socket, you’ll be able 

connect between that and the external input socket at the rear of the VR using an audio cable with 

3.5mm TRS jacks both ends. You’ll also need a standard USB cable with the USB B (square type) 

connector one end (to connect to the USB B socket at the back of the VR) and a USB A (rectangular 

type) connector at the other end (to connect to the hub). That’s the most basic way to connect a 

USB C iPad, but it’ll get you started.  

 

However, you’ll get better sound quality if you invest in a digital audio interface for which you’ll 

need a further standard USB lead (to connect it to the hub dock) and a pair of short audio leads with 

6mm jacks plus each end to connect from the audio outs at the rear of the VR to the audio ins of the 

digital audio interface. Siting a digital audio interface on the VR is tricky but one way of doing it is 

cutting a short bit of 20 x 12mm timber to size and blue tacking it to the top surface of the VR just 

forward of the USB stick well, and having the interface bridge over the D beam and adjacent controls 

(which then become unusable). This will depend on the size of your interface, but certainly a Roland 

Rubix 2x2 fits quite well in this situation. The following image shows the exact set-up described 

above. The hub is a 6-in-1 USB-C clip-on type hub and has a 3.5mm audio socket at its top edge 

which could be used to take audio direct to the external audio input of the VR as a (lower quality) 

alternative to the audio interface if necessary. 

 

 
 

 

Physically connecting an older iPad. These have the lightning connector and an audio out socket, and 

you’ll need an Apple or equivalent camera connection kit (cck), ideally one that allows a charging 

cable to be connected, plus the same cables you’d need for the USB C set up described above. See 

image below (non-charging cck shown). 
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Again that’s the basic set up, but it’ll get you going and if you then want to upgrade to a digital audio 

interface you can and you’ll need the same additional leads referred to for the USB C installation 

above, plus a powered hub dock. 

 

Once you’ve installed KeyStage or KeyStage Lite on your iPad you’d first be well advised to watch the 

introductory tutorial video and try to grasp the basic principles of KeyStage 

https://youtu.be/tECnZHNU2wY?si=UUUBMzg0gZzexfWF  .You can run this from inside the app itself 

- it’s over an hour long and you won’t take it all in at once so maybe run it twice?  

 

OK, now to start the fun bit. In KeyStage, instruments have an ‘Instrument Preset’. This is basically a 

map of all the patches available in that instrument with their addresses. There’s also an Instrument 

Presets Database (Preferences > Instrument Presets Database > Access Database) containing 

Instrument Presets for a lot of popular keyboards and this contains an instrument preset for the 

Roland VR-09. However, you should ignore this - it’s not good enough for our purposes. User 

Graham Stow, utilising data unearthed by Frank V-Combo Editor, has created an Instrument 

Database that contains over 2,500 patches comprising all the main keyboard sound engine’s patches 

(although as GM2 patches and therefore having no FX), all the GM2 patches referred to in the user 

manual, plus the many ‘hidden’ sounds unearthed by Frank. There’s a certain amount of duplication 

because some sounds appear under more than one heading and some with different addresses, but 

that’s unavoidable. This instrument database is a text (.txt) file and can be downloaded at 

https://drive.google.com/file/d/1--qVxOjUd_7fg6_t5Ayyk6LYOhIlz2-a/view?usp=sharing 

Once downloaded, to load into KeyStage, copy it into Dropbox, then tap ‘Share’, then ‘Send copy of 

file’, then scroll until you find ‘KeyStage’ then select it. You’ll then have to name the instrument, so 

name it ‘Roland VR-Ch5+’  (the purpose of adding ‘-ch5+’ is to remind you that you should only use  

channels 5 to 9, 12, 14 &15 to access these sounds) . 

 

OK, now to get a sound out of it! In KeyStage, tap File > New Song. Then, double tap in the top left 

corner (under ‘New Song’) then (top right) tap ‘Output’ then, in the pop up window, ‘MIDI 

Connections’, then ‘Roland VR-ch5+’.  See next image… 
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Then select your input (either the VR keyboard itself, if connected, or possibly an input alias for it if 

you’ve already set one up - check out KeyStage tutorials and the Manual to understand Input 

aliases).  

 

 
 

Finally ensure the Output Channel is Channel 5 and above.  
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You’ve now set up your Roland VR as a KeyStage ‘Track’. Now double tap immediately to the right of 

that and a ‘Part’ (Part 1) will be created under Section 1. With ‘Parameters’ selected in the right 

hand column, tap on the three hyphens under ‘Roland VR-ch5+’ and a window will pop up giving you 

access to the instrument database you loaded earlier from which you can explore the 2,500+ sounds 

now available to you. Select one and give it a play! See image below… 

 

 
 

Repeat the above process and set up another Roland VR Track and Part immediately under the ones 

you just created, but this time select a different patch in the Part. You’ve now created your first 

layer!  

 

Experiment with using a different output channel (but always using channels 5 to 9, 12, 14 or 15). 

Tap back on the first Part you created then tap on ‘Translators’ (top tight). This will then display the 

(default) ‘Standard Translators’ of Range Limiter, Pitch Shifter, and Velocity Translator. Tap on Range 

Limiter and set the active range of this Part as from (say) C3 and above (note that this is much easier 

done when you’re connected as you can then use the keys to assist you in making your selection).  

 

Repeat the whole process for the second Part but this time set the active range from (say) B2 and 

below. You’ve now created your first split! If you want to, you can tap under ‘Pitch Shifter’, tap ‘0’, 

then scroll and tap ‘-12’ to reduce the pitch of that Part by an octave. See image below… 

 

 
 

Tap on ‘Song Mixer’ and adjust the volumes of the two tracks you have created, one with the other.  
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By now you’ve probably beginning to appreciate the power you have at your fingertips. You could go 

on like this creating further tracks and many more parts in further sections creating any number of 

layers and splits, and all without having to change any settings on the Roland VR keyboard itself.  

 

 

2. How to translate the Sysex messages output by the VRs organ controls (drawbars etc) into the 

CC messages required by iOS virtual organs 

 

Why do you need to do this? 

 

There are some excellent software organ synths out there that are arguably better than the VR’s 

native organ and they come with a lot of good presets too. They are invariably controlled by MIDI 

‘Control Change’ (CC) messages, however the VR’s hard organ controls (drawbars, percussion etc) 

send Sysex messages, not Control Change messages. However, KeyStage supports ‘Custom 

Translators’ that, amongst many other uses,  can be used to translate Sysex to CC messages and 

provide perfect control of soft organ synths. VR-09 user Graham Stow has written a ‘VR to VB3m’ 

KeyStage Input Alias that uses a chain of 55 Custom Translators that together allow Roland VRs to 

control both the GSi VB3m and the VB3II virtual organs. Similarly, he has written a ‘VR to B-3X’ 

KeyStage Input Alias that uses a similar chain of Custom Translators that together allow the Roland 

VRs to control IK Multimedia’s Hammond B-3X virtual organ.  

 

2(a). VR to VB3m input MIDI alias 

 

Introduction 

 

The VR to VB3m input MIDI alias utilizes a chain of 55 KeyStage custom translators and, when 

restored to the KeyStage iOS app and selected, enables the user to easily, and almost completely, 

control the GSi VB3m iOS organ app from the Organ and FX controls of a Roland V-Combo VR 

keyboard. It’s been developed and tested with VR-09 software v1.03 although it’s thought highly 

likely to work with other VR-09 software versions, the Roland VR-09B, and the Roland VR-730. 

 

The VR to VB3m input MIDI alias is presented ‘as is’ and no warranty is given or implied. It can be 

downloaded at  

https://drive.google.com/file/d/1-3GQ5rFFDnS_JTUB4KBT733crEESxYyJ/view?usp=sharing 

 

Minimum system requirements 

 

Pretty much as described above under ‘What you need to play the Roland VR’s GM2 Sound Engine 

through KeyStage’ (although you don’t necessarily need the KeyStage ‘Instrument Preset’ for the VR) 

 

Preparation 

 

Users are first advised to install the KeyStage App and, as a minimum, watch and understand the 

KeyStage Introductory Video. The more you understand about how KeyStage works, the easier it will 

be to get the alias installed and working correctly. 

 

Set-Up 

 

In the KeyStage app, create a virtual output port for the VB3m app (Preferences -> MIDI Connections 

-> Virtual MIDI Ports -> Virtual Outputs -> Create a new virtual Output -> VB3m Create). 
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Again in KeyStage, set up two tracks for the VB3m app, the first as an Instrument Unit on channel 1 

and the second as an Active Audio Unit ‘piggybacked’ on the first track, on channel 2. Set up a Part 

for each Track in a Section 1 and for each Part, split the Range using the standard Range Limiter 

Translator (say upper manual on channel 1 from C3 to G8 and lower manual on Channel 2 from C-2 

to B2). There’s no need to set ranges using the VB3m app, nor to change any MIDI channels on the 

VR which can be left as they are, nor is there any need to split the keyboard on the VR itself. 

 

To restore the VR to VB3m input MIDI alias text file into KeyStage, open it in another app on your 

iPad (for example Dropbox) and export it into KeyStage. Double tap on the Part (‘Bright solo’ in this 

case),then drag and reposition the GUI, and your song  file should now look like this  … 

 

 
 

 

And if you go into Preferences > MIDI Connections > Input Aliases, and select ‘VR to VB3m’,then tap 

‘Edit Input Alias’, the top of your VR to VB3m input alias (bearing in mind there are many more 

Custom Translators than the 2 or 3 shown at the top of this file), should look like this… 

 

 
 

Tap on ‘Done’ to close. 
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Playing the GSi VB3m app though the Roland VR 

 

It’s suggested that you close all unnecessary iOS apps and run your iPad in Airplane Mode if 

resources prove to be tight. 

 

Make sure you have ORGAN or ORGAN & PIANO mode(s) selected on the VR (if Piano alone or Synth 

modes are selected, the Sysex message transmitted by some of the controls changes and the 

assignments intended by the alias will not be made). Ensure you set the Level Bar of the VR to Zero 

to mute the VR’s native organ. 

 

To clarify, with the exception of the Overdrive knob, all of the VR’s EFX controls operate as on/off 

switches with left of 12 noon being off, and right of 12 noon being on. 

Finally, the Mapping Chart below confirms how the VB3m parameters are mapped to the hard 

controls on the VR. 

 

 

2(b) VR to B-3X input MIDI alias 

 

Introduction 

 

The VR to B-3X input MIDI alias utilizes a chain of 59 KeyStage custom translators and, when 

restored to the KeyStage iOS app and selected, enables the user to easily, and almost completely, 

control IK Multimedia’s Hammond B-3X iOS organ app from the Organ and EFX controls of a Roland 

V-Combo VR keyboard. It’s been developed and tested with VR-09 software v1.03 although it’s 

thought likely to work with other VR-09 software versions, the Roland VR-09B, and possibly the 

Roland VR-730. If it doesn’t work with other VR-09 software versions or these latter two Keyboards, 

it is thought it could be easily adapted to work with them. 

 

The VR to B-3X input MIDI alias is presented ‘as is’ and no warranty is given or implied. It can be 

downloaded at  

https://drive.google.com/file/d/1-96mq8uf7aPBiZZAPrbQv34ENDz7Azig/view?usp=sharing 

 

Minimum system requirements 

 

Again, pretty much as described above under ‘What you need to play the Roland VR’s GM2 Sound 

Engine through KeyStage’. 

 

Preparation 

 

Again, users are first advised to install the KeyStage App and, as a minimum, watch and understand 

the KeyStage Introductory Video.  

 

Set-Up 

In the Hammond B-3X app, go to the Settings screen and in the MIDI CHANNELS box, set Upper 

Manual and Program Change to channel 11, Lower Manual to channel 12, and Pedal to channel 13. 

Again in B-3X, check that all the CCs displayed on the B-3X under Controls View -> MIDI 

CONTROLLERS on the B-3X app (right side column) are non-inverted and unlatched (i.e. all highlights 

removed, if any). 
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In the KeyStage app, create a virtual output port for the Hammond B-3X (Preferences -> MIDI 

Connections -> Virtual Outputs -> Create a new virtual Output -> B-3X Create) 

Again in KeyStage, set up two tracks for the Hammond B-3X, one on channel 11 and one on channel 

12. Then go to KeyStage’s ‘Main View’ and split the parts for each track, say upper manual on 

channel 11 from C3 to G8 and lower manual on Channel 12 from C-2 to B2. 

To restore the VR-09 to B-3X input MIDI alias text file into KeyStage, open it in another app on your 

iPad and export it into KeyStage.  

Now refer to the Mapping Chart for B-3X hereunder. The CCs displayed on the B-3X under Controls 

View -> MIDI CONTROLLERS on the B-3X app (right side column) MUST be identical to those in the 

alias (second left column). It's very unlikely that these will be identical 'out of the box' - your B-3X 

may be on factory CCs, in which case the instances where the alias differs from these are highlighted 

in red (which you need to change from) and green (which you need to change to) on the mapping 

chart. There are three ways of achieving this: (1) where necessary, change the CCs in the B-3X app to 

match those in the alias (which is the option the Mapping Chart assumes you’ll use), (2) where 

necessary, change the CCs used in the ‘Output’ field of the relevant KeyStage custom translators to 

match that used by the B-3X app and ‘Save Current State’ of all those you change, or (3) a 

combination of (1) and (2) above. If you chose method (2), the KeyStage custom translators you’ll 

need to change are shown in the second column from the right. The CCs column headed ‘User’ is 

intended for you to note down the CCs your B-3X uses so you can work out those you need to 

change and decide where they are best changed (i.e. in the B-3X app or in the KeyStage translators) 

Playing the Hammond B-3X app though a Roland VR keyboard 

 

In iPad Settings, scroll down and click on the Hammond B-3X app and enable Background Audio. It’s 

also suggested that you close all unnecessary iOS apps and run your iPad in Airplane Mode if 

resources prove to be tight. 

 

Make sure you have ORGAN or ORGAN & PIANO mode(s) selected on the VR (if Piano alone or Synth 

modes are selected, the Sysex message transmitted by some of the controls changes and the 

assignments intended by the alias will not be made). Ensure you set the Level Bar of the VR to Zero 

to mute the VR’s native organ. 

 

Again, with the exception of the Overdrive knob, all of the VR’s EFX controls operate as on/off 

switches with left of 12 noon being off, and right of 12 noon being on. 

The Mapping Chart below confirms how the B-3X parameters are mapped to the hard controls on 

the VR. 

 

Finally, there is another interesting way to play soft organs using KeyStage - take a look at the next 

image. With this set up, particularly if you use a Bluetooth pedal to change sections, you can move 

between split keyboard, lower manual and upper manual set ups, very quickly, which can be very 

useful if you’re playing jazz organ. But for it to work, you first need to visit Song Properties and turn 

off ‘Suspend inactive plugins to improve performance’, otherwise the system will sense that the 

track containing the patch is inactive, and turn it off to conserve resources. This method can equally 

be used for the VB3m organ discussed earlier  
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3. Using the Roland V-Combo VR keyboards to play iOS instruments via KeyStage 

 

Minimum system requirements 

 

Pretty much as described above under ‘What you need to play the Roland VR’s GM2 Sound Engine 

through KeyStage’ (although you don’t necessarily need the KeyStage ‘Instrument Preset’ for the VR) 

 

Getting started with iOS instrument apps 

 

If you don’t have any, download a couple of iOS instruments apps. Try to ensure these are AUv3 

(Audio Unit compatible) as they then open as Audio Units directly in KeyStage and don’t need to be 

run in the background. Two good (and free or low-cost) ones to get you started are Numa Player 

(free) https://apps.apple.com/gb/app/numa-player/id1601231132  

and House: Mark 1 (low cost) https://apps.apple.com/gb/app/house-mark-i/id1481734663 

 

In KeyStage, under Preferences -> Input Aliases, tap on Create New Input Alias (call it whatever you 

want) then select that it as your MIDI Input. 

 

If your iOS instrument app works only on a certain MIDI channel, change your Output Channel to the 

same channel. 

 

Again in KeyStage, create a Track on the left side, then in Preferences -> Output, choose the 

Instrument Units category and your new app(s) will show up. Tap on the app you want and it will 

load. Tap to its right and a Part will be created. Possibly you can then select an Audio Unit Preset 

(depending on whether the instrument has any Factory Presets or not), but if it doesn’t you can 

create your own as KeyStage Presets by double tapping on the track, selecting the patch you want 

within the app itself, then tapping on Presets in the top right corner of the Instrument Unit window, 

and saving the current state as a KeyStage Preset. 
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One thing to bear in mind is that it’s entirely possible to split and layer both VR patches and IOS 

instrument patches if you wish to. 

 

The following image is taken from the main view of the single song file the writer is using for live gigs 

with his current band. Note the player unit which is set up to play the approx 10 second ‘guitar palm 

slap’ intro sampled from the actual recording of ‘Eye Of The Tiger’. Only AUV3 Instrument Unit 

outputs are shown here – there are a few Roland VR MIDI outputs elsewhere in the file, but not 

many. This is the direction KeyStage can take you in – yes it does open up the full range of sounds 

within the Roland VR keyboard series to you, but it also opens your eyes to the countless and 

expanding  sounds in the iOS world, and once there there may be no going back. And you also start 

thinking about little tricks you can do with KeyStage – like programming a small range of maybe just 

4 notes that will add a major third to them and allow you to play a fast passage that you would 

otherwise find impossible to play. There’s a lot to learn but the above should get you started. 

KeyStage can make a good keyboard sound even better. 

 

 
 

 

 

Enjoy! 
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Roland V-Combo VR Keyboard to GSi VB3m iOS App input MIDI alias

No. Names
Names of translators assigning 

VB3m CCs

Vibrato Upper 31 2 Vibrato Swell 1&2 Vibrato Swell 2 ( VIBRATO/CHORUS button

Vibrato Lower 30 1 Vibrato Great Vibrato Great ( VIBRATO/CHORUS button

Vibrato Select 73 8 Vibrato Type 1-8 Vibrato Type 8 VIBRATO/CHORUS button and VALUE dial

Percussion On/Off 66 7 Percussion On/Off 1-7 Percussion On/Off 2-7 PERCUSSION button

Percussion Volume 70 3 Percussion Volume 1-3 Percussion Volume 2&3 VALUE dial and CURSOR buttons

Percussion Decay 71 4 Percussion Decay 1-4 Percussion Decay 1-4 VALUE dial and CURSOR buttons

Percussion Harmonic 72 4 Percussion Harmonic 1-4 Percussion Harmonic 1-4 VALUE dial and CURSOR buttons

Swell Pedal 11 EXPRESSION PEDAL works 'as is'

Drawbar Upper 1 12 2 Upper Drawbar 1-1&2 Upper Drawbar 1-2 16' Harmonic Bar

Drawbar Upper 2 13 2 Upper Drawbar 2-1&2 Upper Drawbar 2-2 5 1/3' Harmonic Bar

Drawbar Upper 3 14 2 Upper Drawbar 3-1&2 Upper Drawbar 3-2 8' Harmonic Bar

Drawbar Upper 4 15 2 Upper Drawbar 4-1&2 Upper Drawbar 4-2 4' Harmonic Bar

Drawbar Upper 5 16 2 Upper Drawbar 5-1&2 Upper Drawbar 5-2 2 2/3' Harmonic Bar

Drawbar Upper 6 17 2 Upper Drawbar 6-1&2 Upper Drawbar 6-2 2' Harmonic Bar

Drawbar Upper 7 18 2 Upper Drawbar 7-1&2 Upper Drawbar 7-2 1 3/5' Harmonic Bar

Drawbar Upper 8 19 2 Upper Drawbar 8-1&2 Upper Drawbar 8-2 1 1/3' Harmonic Bar

Drawbar Upper 9 20 2 Upper Drawbar 9-1&2 Upper Drawbar 9-2 1' Harmonic Bar

Drawbar Lower 1 21 -

Drawbar Lower 2 22 -

Drawbar Lower 3 23 -

Drawbar Lower 4 24 -

Drawbar Lower 5 25 -

Drawbar Lower 6 26 -

Drawbar Lower 7 27 -

Drawbar Lower 8 28 -

Drawbar Lower 9 29 -

Drawbar Pedal 1 33 -

Drawbar Pedal 2 35 -

Amp Select 85 1 Amp Select (MFX knob) Amp Select (MFX knob) MFX knob (4 positions, L to R)

Rotary Lever 1 ROTARY SOUND (FAST/SLOW) button

Rotary Lever (via Sustain) 64

Set SUSTAIN PEDAL Switch to Rotary 

Fast/Slow under Menu > Controller > Damper 

Assign.  D-BEAM/ CONTROLLER works with 

this too.

Rotary Lever (Brake) 1 1 Leslie Brake Leslie Brake ROTARY SOUND (ON/OFF) button

Mic Distance 93 -

Mic Balance 90 -

Volume 7 VOLUME

Bass 8 1 Bass (TONE knob) Bass (TONE knob) TONE knob

Treble 10 1 Treble (COMPRESSOR knob) Treble (COMPRESSOR knob) COMPRESSOR knob

KeyClick 75 1 KeyClick (DELAY knob) KeyClick (DELAY knob) DELAY knob

Drive 76 1 Drive (OVERDRIVE knob) Drive (OVERDRIVE knob) OVERDRIVE knob

Reverb 91 1 Reverb (REVERB knob) Reverb (REVERB knob) REVERB knob

Split On OFF -

Split Point OFF -

Pedal to Lower OFF -

Pedal Decay 56 -

Not translated (not enough drawbars on VR)

Not translated (not enough knobs on VR)

Not translated (not enough knobs on VR)

Not translated (not enough drawbars on VR)

Not translated (not enough drawbars on VR)

Not translated (not enough drawbars on VR)

Not translated (not enough drawbars on VR)

Not translated (not enough drawbars on VR)

Not translated (not enough drawbars on VR)

Not translated (not enough drawbars on VR)

Not translated (not enough drawbars on VR)

Not translated (not enough drawbars on VR)

Not translated (not enough drawbars on VR)

Not translated (not enough knobs on VR)

Not translated (not enough knobs on VR)

Not translated (not enough knobs on VR)

Not translated (not enough knobs on VR)

MAPPING CHART

GSi VB3m v 1.2.3 KeyStage VR to VB3m input MIDI alias

VB3m parameters mapped to the following 

on the Roland V-Combo VRParameters

Custom Translators

CCs

1 Leslie Fast/Slow Leslie Fast/Slow

Not translated (suggest set in KeyStage 'Part' and adjust with 

KeyStage 'Live Console/Main Mixer' and/or VR volume control)

No custom translators needed
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Using the KeyStage Master Controller iOS app with a Roland V-Combo VR Keyboard

Roland V-Combo VR Keyboard to IK Multimedia Hammond B-3X iOS App input MIDI alias

VR to               

B-3X input 

MIDI alias

Factory User No. Names
Names of translators 

assigning B-3X CCs

Leslie Speed 1 1 1 Leslie Fast/Slow Leslie Fast/Slow ROTARY SOUND (FAST/SLOW) button

Leslie Brake 93 93 1 Leslie Brake Leslie Brake ROTARY SOUND (ON/OFF) button

Master Volume 7 7 -

Expression 11 11 EXPRESSION PEDAL works 'as is'

Leslie Amp Gain 60 42 1 Leslie Gain Leslie Gain OVERDRIVE knob

Percussion On/Off 66 36 7 Percussion On/Off 1-7 Percussion On/Off 2-7 PERCUSSION button

Percussion 2nd/3rd 72 44 4 Percussion Harmonic 1-4 Percussion Harmonic 1-4 VALUE dial and CURSOR buttons

Percussion Volume 70 37 3 Percussion Volume 1-3 Percussion Volume 2&3 VALUE dial and CURSOR buttons

Percussion Decay 71 43 4 Percussion Decay 1-4 Percussion Decay 1-4 VALUE dial and CURSOR buttons

Vibrato Type 38 38 8 Vibrato Type 1-8 Vibrato Type 8 VIBRATO/CHORUS button and VALUE dial

Vibrato Great 30 39 1 Vibrato Great Vibrato Great ( VIBRATO/CHORUS button

Vibrato Swell 31 40 2 Vibrato Swell 1&2 Vibrato Swell 2 ( VIBRATO/CHORUS button

Volume 41 41 Not translated -

Upper Drawbar 1 12 12 2 Upper Drawbar 1-1&2 Upper Drawbar 1-2 16' Harmonic Bar

Upper Drawbar 2 13 13 2 Upper Drawbar 2-1&2 Upper Drawbar 2-2 5 1/3' Harmonic Bar

Upper Drawbar 3 14 14 2 Upper Drawbar 3-1&2 Upper Drawbar 3-2 8' Harmonic Bar

Upper Drawbar 4 15 15 2 Upper Drawbar 4-1&2 Upper Drawbar 4-2 4' Harmonic Bar

Upper Drawbar 5 16 16 2 Upper Drawbar 5-1&2 Upper Drawbar 5-2 2 2/3' Harmonic Bar

Upper Drawbar 6 17 17 2 Upper Drawbar 6-1&2 Upper Drawbar 6-2 2' Harmonic Bar

Upper Drawbar 7 18 18 2 Upper Drawbar 7-1&2 Upper Drawbar 7-2 1 3/5' Harmonic Bar

Upper Drawbar 8 19 19 2 Upper Drawbar 8-1&2 Upper Drawbar 8-2 1 1/3' Harmonic Bar

Upper Drawbar 9 20 20 2 Upper Drawbar 9-1&2 Upper Drawbar 9-2 1' Harmonic Bar

Lower Drawbar 1 21 21 Not translated -

Lower Drawbar 2 22 22 Not translated -

Lower Drawbar 3 23 23 Not translated -

Lower Drawbar 4 24 24 Not translated -

Lower Drawbar 5 25 25 Not translated -

Lower Drawbar 6 26 26 Not translated -

Lower Drawbar 7 27 27 Not translated -

Lower Drawbar 8 28 28 Not translated -

Lower Drawbar 9 29 29 Not translated -

Pedal Drawbar 1 33 33 Not translated -

Pedal Drawbar 2 35 35 Not translated -

Overscream On 95 50 1 Overscream On/Off Overscream On/Off MFX knob (off  < noon > on)

EQ PG On 47 51 Not translated -

Chorus C1 On 43 52 1 Chorus C1 On/Off Chorus C1 On/Off TONE knob (off  < noon > on)

Spring Reverb On 51 53 1 Spring Reverb On/Off Spring Reverb On/Off DELAY knob (off  < noon > on)

Wah On 65 54 3 Wah 1-3 Wah 2&3 LEVEL bar (off ^; on ˅)

Wah Pedal 73 55 1 Wah 4 Wah 4 LEVEL bar (˅^)

Compressor On 39 56 1 Compressor On/Off Compressor On/Off COMPRESSOR knob (off  < noon > on)

EQ-81 On 98 57 Not translated -

Reverb On 54 58 1 Reverb On/Off Reverb On/Off REVERB knob (off  < noon > on)

Sustain 64 64

Set SUSTAIN PEDAL Switch to Rotary 

Fast/Slow under Menu > Controller > 

Damper Assign

MAPPING CHART

NOTE: The MIDI Controller CC numbers in the Hammond app MUST be changed to equate with those in the KeyStage input MIDI alias (i.e. from red to green)

Not translated (suggest set in KeyStage 'Part' and adjust in KeyStage 

'Live Console')

No custom translators needed

No custom translators needed to control Leslie Speed

Hammond B-3X KeyStage VR > B-3X input MIDI alias

Hammond B-3X controls mapped to the 

following on the Roland VR

MIDI Controller          

(all non-inverted and 

unlatched)

CCs Custom Translators
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